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1 Introduction

1.1 Overview

MQCT-GUI application allows the user to create or update MQCT IniFiles.  MQCT-GUI can run on 
any platform that supports Java v1.6 (or higher): Linux, Mac OS X and Windows Vista/7/8/8.1/10. 

MQ Channel Throttler (MQCT) provides the ability to control/throttle the number of connection calls,
open calls and/or messages (or bytes) that flow over a channel.  MQCT operates with IBM MQ v7.0, 
v7.1, v7.5 v8.0, v9.0, v9.1 and v9.2 in Windows, Unix, IBM i (OS/400) and Linux environments. It 
operates with Sender, Receiver, Server, Requester, Cluster-Sender, Cluster-Receiver and Server 
Connection channels of the MQ queue managers. 

MQCT is a simple drop-in solution that provides throttling for MQ queue managers. The throttling can
be configured for queue manager to queue manager channels or for client application to queue manager
channels.  

 Queue manager to queue manager throttling means all messages (or bytes) flowing over a 
channel between 2 queue managers will be throttled.

 Client application to queue manager throttling means application-level connection calls, open 
calls and/or messages (or bytes) flowing between a MQ client application and queue manager will be 
throttled.

MQCT can be used to throttle the following MQ API calls: MQCONN, MQCONNX, MQOPEN, 
MQGET, MQPUT and MQPUT1.

The MQCT can be configured as a channel message exit or as a channel send/receive exit.

On AIX, HP-UX, Linux, Solaris and Windows, MQCT can be configured and used with a non-default 
installation of MQ in a multi-install MQ environment.
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2 Installation
This chapter will describe the installation and configuration (optional) of MQCT-GUI. For Windows 
users, the installation of MQCT-GUI is very simple and straightforward. Other Operating Systems will
need to unzip the downloaded software package.

2.1 Prerequisites
This section lists the required hardware and software components needed to run the MQCT-GUI 
application. 

2.2 Software
The following third party software components must be installed in order to properly run MQCT-GUI: 

 Java Runtime Environment (JRE) 1.6 (or higher) or Java 2 SDK, Standard Edition (J2SE) v1.6 
(or higher) 

2.3 Hardware / OS
MQCT-GUI is capable of running on the following hardware platforms that support Java v1.6 (or 
higher): 

 Linux
 Mac OS X
 Windows Vista, 7, 8, 8.1 & 10

2.4 Setting Up and Running the Application
The following section provides instructions on installing and running the MQCT-GUI application.

2.4.1 For Windows Users:

 Run the install program called: mqctgui-setup-withjre.exe 

 The installer should follow the standard Windows install procedures and provide default values
for the users. 

 When the install program has installed MQCT-GUI, there will be a newly created folder under 
Start -> All Programs called MQCT-GUI. 

 To run MQCT-GUI, select the MQCT-GUI icon from within the MQCT-GUI folder. 
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2.4.2 For Linux and Max OS X (requires JRE/JDK):

 MQCT-GUI is provided as a zip file: mqctgui.zip 

 To unzip the file, open a shell prompt and execute the following commands: 

unzip mqctgui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQCT-GUI 

 Change directory by typing the following:

cd Capitalware/MQCT-GUI 

 Before running MQCT-GUI for the first time, you need to add the execute attribute to the 
mqctgui.sh shell scripts. Type the following: 

chmod +x mqctgui.sh 

 To run MQCT-GUI from the Capitalware/MQCT-GUI directory, then type the following: 

./mqctgui.sh 
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3 Creating / Updating IniFiles
This chapter will describe the how to create and/or update IniFiles.

3.1 New IniFile
This section will describe how to create a new MQCT IniFile. The IniFile can be for a local or remote 
MQCT implementation. 

From the main menu of MQCT-GUI, select File then New File 

The following is the New IniFile panel: 

Fill in the following information: 
 Input a file name including the file extension of '.ini'
 Select the Operating System
 Choose between a 32-bit or 64-bit environment

Finally, click the Ok button to create and open the new MQCT IniFile.
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3.2 Open an IniFile
This section will describe how to open a MQCT IniFile to be viewed or edited. The IniFile can be for a
local or remote MQCT implementation. 

From the main menu of MQCT-GUI, select File then Open File 

The following is the Open dialog box: 

Select the IniFile that you wish to view / edit and then press the Open button.
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3.3 Close an IniFile
This section will describe how to close a MQCT IniFile. 

From the main menu of MQCT-GUI, select File then Close 

If the user has altered the IniFile then the user will be presented with the following dialog box: 

Select Yes to save the changes otherwise select No. 

The MQCT-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.4 Save IniFile
This section will describe how to save an open MQCT IniFile. 

From the main menu of MQCT-GUI, select File then Save 

The parameter information will be saved to the IniFile. 

The MQCT-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.5 Save As IniFile
This section will describe how to save an open MQCT IniFile. 

From the main menu of MQCT-GUI, select File then Save As 

Select or Input the IniFile name that you wish use then press the Save button. 
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4 Tabs
This chapter will describe the various parameters on each tab.

4.1 General Tab
This section will describe various parameters on the General tab of a MQCT IniFile. 
The following is a General Tab with default values: 

The IniFile keywords and their values on the General Tab are discussed below.
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4.1.1 General
This section describes the general keywords and their values.

 Active controls enabling or disabling MQCT.

 Description parameter is optional and is not used by MQCT.  It can be used to provide a brief 
description / purpose of the IniFile. 

 License key is provided by Capitalware Inc. The license is for a particular queue manager. 
Your license will look something like: 1000-AAAA-BBBBBBBB (Note: This is a sample license only 
and will NOT work). 

 LicenseFile specifies the location of License file that contains all of the customer's license 
keys.  The following are the default values for LicenseFile:

• For Windows: C:\Capitalware\MQCT\mqct_licenses.ini
• For IBM MQ 32-bit on Unix & Linux: /var/mqm/exits/mqct_licenses.ini
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqct_licenses.ini
• For IBM i: /QIBM/UserData/mqm/mqct/mqct_licenses.ini

 IniFileRecheckTime specifies the amount, in seconds, before the IniFile is checked whether it 
has changed or not.  The default value is 60.

4.1.2 API Types
This section describes the keywords related to functionality.

 APIType  specifies the throttling to be against MQCONN, MQCONNX, MQOPEN, MQGET, 
MQPUT and/or MQPUT1.  The default value is 'Get and Put'.

• Connect means that MQCT will throttle for MQCONN and MQCONNX calls
• Open means that MQCT will throttle for MQOPEN call
• Get means that MQCT will throttle for MQGET call
• Put means that MQCT will only throttle for MQPUT and MQPUT1 calls
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4.1.3 Throttle Rates
This section describes the keywords for the global encryption / decryption settings.

 ConnectionRate specifies the maximum number of connection calls to be allowed over the 
channel in a given period of time. i.e. 25/s

 OpenRate specifies the maximum number of open calls to be allowed over the channel in a 
given period of time. i.e. 30/s

 ByteRate specifies the maximum number of bytes to be allowed over the channel in a given 
period of time. i.e. 100KB/m  Note: Only used if APIType is set to Put and/or Get.

 MessageRate specifies the maximum number of messages to be allowed over the channel in a 
given period of time. i.e. 55/s  Note: Only used if APIType is set to Put and/or Get.

Note: If ByteRate is used then MessageRate is ignored.

4.1.4 Usage
This section describes the keywords related to usage.

 UseCombinedGetPutRates specifies whether or not the throttles should be based on the 
combined total of gets and puts.  UseCombinedGetPutRates supports 2 values [Y / N].  The default 
value is Y.
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4.1.5 Logging
This section describes the keywords related to logging and their values.

 LogMode specifies what type of logging the user wishes to have. LogMode supports 4 values: 
Quiet, Normal, Verbose and Debug. The default value is Normal. 

 LogFile specifies the location of the log file. The default is as follows: 
• For Windows: C:\Capitalware\MQCT\mqct.log 
• For IBM MQ 32-bit on Unix and Linux: /var/mqm/exits/mqct.log 
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqct.log
• For IBM I: /QIBM/UserData/mqm/mqct/mqct.log

 
 RotateLogDaily specifies whether or not MQCT when auto-rotate the log files.  The default 
value is Yes.

 BackupLogFileCount specifies the number of backup log files to be kept / retained.  The 
default value is 9.

 WriteToSystemLog specifies for each connection attempt that a log entry be written to the 
system log. 

• For Windows this would be the Event Log 
• For Unix and Linux this would be the syslog. 

 WriteToEventQueue specifies for each failed connection attempt that a log entry be written to
the specified event queue. 

 EventQueueName specifies the name of the queue that the event message will be written to. 
The default is as follows: 'SYSTEM.ADMIN.CHANNEL.EVENT'.
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5 Other Tools
This chapter will describes how the other tools included with MQCT-GUI.

5.1 Hex Converter
This section will describe how to invoke and use the Hex Converter tool. Hex Converter tool can 
convert a hexadecimal number to its corresponding string representation and vice versa. i.e. 
0x'3132333041424344' to '1230ABCD'.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then Hex Converter.

This is the main panel of the Hex Converter.

• The user first selects the Conversion type: "Hex to Character" or "Character to Hex"
• Input the value hex or character value into the "Input Value" field
• Click the Convert button to convert the data
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5.2 Hex Editor
This section will describe how to invoke and use the Hex Editor tool. The Hex Editor is a simple 
multipurpose hex editor. The Hex Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then Hex Editor.

This is the main panel of the Hex Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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5.3 Tail File
This section will describe how to invoke and use the Tail File tool. The Tail File is a simple 
multipurpose file monitoring viewer. The Tail File supports monitoring of multiple files at the same 
time.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then Tail File.

This is the main panel of the Tail File and it has 3 open files.

Supported features:
• Opening of multiple files
• Wrap Text and Recent File List
• Copy, Find, Find Next and Print
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5.4 Text Editor
This section will describe how to invoke and use the Text Editor tool. The Text Editor is a simple 
multipurpose plain-text editor. The Text Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then Text Editor.

This is the main panel of the Text Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Builtin XML Viewer, Wrap Text
• Recent File List
• Cut, Copy, Paste, Find and Find Next
• Save, Save As and Print
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The following shows the Text Editor's builtin XML Viewer.
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5.5 Visual Difference
This section will describe how to invoke and use the Visual Difference tool. The Visual Difference is a
simple file to file comparison tool.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then Visual Difference.

This is the main panel of the Visual Difference. To initiate the file comparison process, click File and 
then click Compare File to File

First the user needs to select the first file for the comparison.
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Next, the user needs to select the second file for the comparison.

The following shows the difference between 2 files. Differences are highlighted: Green for inserts, Red
for deletions and Blue for changes.
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5.6 XML Editor
This section will describe how to invoke and use the XML Editor tool. The XML Editor is a simple 
multipurpose plain-text editor. The XML Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCT-GUI.

From the main panel of MQCT-GUI, select Tools, then XML Editor.

This is the main panel of the XML Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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6 Miscellaneous
This chapter will describes how the miscellaneous features of MQCT-GUI.

6.1 Language
This section will describe how to switch MQCT-GUI's Language Text to another Language Text. 
MQCT-GUI has been designed to support Java's multi-language environment.  Currently, MQCT-GUI 
has language support (menu items, buttons and titles) for the following 55 languages:

 Amharic (am)
 Arabic (ar)
 Azerbaijani (az)
 Bengali (bn)
 Cebuano (ceb)
 Chinese (China) (zh)
 Chinese (Taiwan) (zh)
 Czech (cs)
 Danish (da)
 Dutch (nl)
 English (en)
 Finnish (fi)
 French (fr)
 German (de)
 Greek (el)
 Gujarati (gu)
 Hausa (ha)
 Hebrew (iw)
 Hindi (hi)

 Hungarian (hu)
 Igbo (ig)
 Indonesian (in)
 Italian (it)
 Japanese (ja)
 Javanese jv)
 Kannada (kn)
 Korean (ko)
 Malay (ms)
 Malayalam (ml)
 Marathi (mr)
 Norwegian (no)
 Panjabi (pa)
 Pashto (ps)
 Persian (fa)
 Polish (pl)
 Portuguese (pt)
 Romanian (ro)
 Russian (ru)

 Shona (sn)
 Sindhi (sd)
 Spanish (es)
 Sundanese (su)
 Swahili (sw)
 Swedish (sv)
 Tamil (ta)
 Telugu (te)
 Thai (th)
 Turkish (tr)
 Ukrainian (uk)
 Urdu (ur)
 Uzbek (uz)
 Vietnamese (vi)
 Xhosa (xh)
 Yoruba (yo)
 Zulu (zu)

From the main panel of MQCT-GUI, select View, then Language.

MQCT-GUI User Guide                      Page 21



6.2 Reset View
This section will describe how to reset the view of MQCT-GUI if the display is not correct.

The user can also reset the view from the command line by passing in the RG parameter.

6.2.1 Windows Command Line
On Windows, issue the following command to reset the view of MQCT-GUI:

mqctgui.exe  RG

6.2.2 Linux and macOS Command Line
On Linux and macOS, issue the following command to reset the view of MQCT-GUI:

./mqctgui.sh  RG
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7 Appendix A – Frequently Asked Questions (FAQ)

Q. Can IniFiles be create on Windows for MQCT on Unix?
A. Yes. Once the IniFile has been saved, the user can copy or ftp (in ASCII mode) 
the file to the remote server.
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8 Appendix B – MQCT-GUI Upgrade Procedures
To upgrade an existing installation of MQCT-GUI, please do the following in the appropriate section 
below.

8.1 Windows Upgrade
 Stop all instances of  MQCT-GUI
 Backup any MQCT-GUI data files in the MQCT-GUI install directory
 Go to the Windows Control Panel and select Program and Features
 Select MQCT-GUI and then click the Uninstall button
 Run the install program called: mqctgui-setup-withjre.exe
 The installer follows the standard Windows install procedures and provides default values for 

the user.
 When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQCT-GUI.
 Restore the MQCT-GUI data files if necessary
 To run MQCT-GUI, select the MQCT-GUI icon from within the MQCT-GUI folder.

8.2 Linux or macOS Upgrade
 Stop all instances of  MQCT-GUI
 Backup any MQCT-GUI data files in the MQCT-GUI install directory
 Remove the installation i.e. rm -Rf Capitalware/MQCT-GUI/
 Unzip the file, open a shell prompt and execute the following commands: 

unzip mqctgui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQCT-GUI 

 Change directory by typing the following:

cd Capitalware/MQCT-GUI 

 Before running MQCT-GUI for the first time, you need to add the execute attribute to the 
mqctgui.sh shell scripts. Type the following: 

chmod +x mqctgui.sh 

 To run MQCT-GUI from the Capitalware/MQCT-GUI directory, then type the following: 

 ./mqctgui.sh
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9 Appendix C – Support
The support for MQCT-GUI can be found at the following location:

By email at:
support@capitalware.com

By regular mail at:

Capitalware Inc.
Attn: MQCT-GUI Support
Unit 11, 1673 Richmond Street, PMB524
London, Ontario  N6G2N3
Canada
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10 Appendix D – Summary of Changes

 MQCT-GUI v1.3.0
o Added new keyword: UseCombinedGetPutRates - default value is 'Y'

 MQCT-GUI v1.2.0
o Added the ‘Recent Files’ menu option under the File menu option.
o Added images to buttons for more user-friendly display.
o Added support for 55 languages for the menu options, buttons and titles (not IniFile 

keywords).
o Added the ‘Reset View’ menu option under the View menu option.
o Added 6 tools under the Tools menu option: 

 Compare File to a File
 Hex Converter
 Hex Editor
 Tail File
 Text Editor
 XML Editor

 MQCT-GUI v1.1.0
o Initial release.
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11 Appendix E – License Agreement
This is a legal agreement between you (either an individual or an entity) and Capitalware Inc. By 
opening the sealed software packages (if appropriate) and/or by using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly 
return the disk package and accompanying items for a full refund.
SOFTWARE LICENSE

1. GRANT OF LICENSE. This License Agreement (License) permits you to use one copy of the 
software product identified above, which may include user documentation provided in on-line or 
electronic form (SOFTWARE). The SOFTWARE is licensed as a single product, to an individual 
queue manager, or group of queue managers for an Enterprise License. This Agreement requires that 
each queue manager of the SOFTWARE be Licensed, either individually, or as part of a group.  Each 
queue manager's use of this SOFTWARE must be covered either individually, or as part of an 
Enterprise License. The SOFTWARE is in use on a computer when it is loaded into the temporary 
memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that computer. This 
software may be installed on a network provided that appropriate restrictions are in place limiting the 
use to registered queue managers only.  Each licensed queue manager will be provided with a perpetual
license key and the licensee may continue to use the SOFTWARE, so long as the licensee is current on
the Yearly Maintenance Fee.  If the licensee stops paying the Yearly Maintenance Fee, then the 
SOFTWARE must be removed from all systems at the end of the current maintenance period.

2. COPYRIGHT. The SOFTWARE is owned by Capitalware Inc. and is protected by United States Of 
America and Canada copyright laws and international treaty provisions. You may not copy the printed 
materials accompanying the SOFTWARE (if any), nor print copies of any user documentation 
provided in on-line or electronic form. You must not redistribute the registration codes provided, either
on paper, electronically, or as stored in the files mqct.ini, mqct_licenses.ini or any other form.

3. OTHER RESTRICTIONS. The registration notification provided, showing your authorization code 
and this License is your proof of license to exercise the rights granted herein and must be retained by 
you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License 
on a permanent basis, provided you transfer this License, the SOFTWARE and all accompanying 
printed materials, retain no copies, and the recipient agrees to the terms of this License. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except to the extent the foregoing 
restriction is expressly prohibited by applicable law.

LIMITED WARRANTY

LIMITED WARRANTY. Capitalware Inc. warrants that the SOFTWARE will perform substantially 
in accordance with the accompanying printed material (if any) and on-line documentation for a period 
of 365 days from the date of receipt.

CUSTOMER REMEDIES. Capitalware Inc. entire liability and your exclusive remedy shall be, at 
Capitalware Inc. option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE that does not meet this Limited Warranty and that is returned to Capitalware Inc. with a 
copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from 
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accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Capitalware Inc. 
disclaims all other warranties, either express or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any 
accompanying written materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall Capitalware Inc. be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the SOFTWARE, even if 
Capitalware Inc. has been advised of the possibility of such damages.
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12 Appendix F – Notices

Trademarks:

AIX, IBM, MQSeries, OS/2 Warp, OS/400, iSeries, MVS, OS/390, WebSphere, IBM MQ and z/OS 
are trademarks of International Business Machines Corporation.

HP-UX is a trademark of Hewlett-Packard Company.

Intel is a registered trademark of Intel Corporation.

Java, J2SE, J2EE, Sun and Solaris are trademarks of Sun Microsystems Inc.

Linux is a trademark of Linus Torvalds.

Mac OS X is a trademark of Apple Computer Inc.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

UNIX is a registered trademark of the Open Group.

WebLogic is a trademark of BEA Systems Inc.
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